
1 / 86

SLAMGO POST PRO V3.0.1.3

Shenzhen Feima Robotics Technology Co., Ltd.

V 3.0.1.3

2026-06-09



2 / 86

Catalog
1. Software Overview ............................................................................................................................6

2. System Requirements ....................................................................................................................... 6

3. Graphics Driver Compatibility ......................................................................................................... 6

4. Hardware Requirements ..................................................................................................................7

5. Software Installation .........................................................................................................................7

6. Software Interface ............................................................................................................................. 8

6.1 Menu Bar ................................................................................................................................... 8

6.2 Common Toolbar ..................................................................................................................... 9

6.3 LOG ............................................................................................................................................ 9

6.4 Quick Access Toolbar ...............................................................................................................9

6.5 Project List Window ............................................................................................................... 10

6.6 View Window .......................................................................................................................... 11

6.7 Processing Log & Progress Bar ..............................................................................................12

7. File Menu .......................................................................................................................................... 12

7.1 Create New Project ................................................................................................................ 13

7.2 Coordinate System Selection ............................................................................................... 14

7.3 Custom Ellipsoid .................................................................................................................... 15

7.4 Work Mode .............................................................................................................................. 15

7.5 Open Project ...........................................................................................................................16

7.6 Recently Opened Projects ..................................................................................................... 17

7.7 Save Project ............................................................................................................................18

7.8 Save as Project ....................................................................................................................... 18

7.9 Close All Projects ....................................................................................................................19

7.10 Export Data ........................................................................................................................... 19

7.11 Exit .........................................................................................................................................19

8. Solve ................................................................................................................................................. 19

8.1 Onekey Solve ......................................................................................................................... 20

8.1.1 Panorama and Colorization – Image Source Settings ..............................................22

8.1.2 Point Cloud Colorization – Settings ........................................................................... 22

8.2 Batch Processing ...................................................................................................................23

8.3 Point Cloud Mapping ............................................................................................................. 25

8.4 Orientation ............................................................................................................................. 26



3 / 86

8.5 Point Cloud Optimization ......................................................................................................26

8.6 Denoise ................................................................................................................................... 27

8.7 Dedistortion ............................................................................................................................28

8.8 Point Cloud Coloring ..............................................................................................................28

8.9 Panorama Generation ........................................................................................................... 30

8.10 Move Object Filter ................................................................................................................ 31

8.11 3DGS Pre-Training ...............................................................................................................31

8.12 3DGS Training .......................................................................................................................32

8.13 Cancel Processing ................................................................................................................ 33

9. Tools ................................................................................................................................................. 33

9.1. Format Convert .................................................................................................................... 34

9.2 PPK Solve ................................................................................................................................ 35

9.3 Accuracy Report ..................................................................................................................... 36

9.4 Data Frame ............................................................................................................................. 37

9.5 Data registration .................................................................................................................... 38

9.6 Data cut ...................................................................................................................................40

9.7 Data Cut Output Mode ...........................................................................................................40

9.8 Create DOM .............................................................................................................................41

9.9 Multiple fights of stitching .....................................................................................................41

9.10 Volume Calculations ............................................................................................................ 42

9.11 Change Analysis ................................................................................................................... 45

9.12 Point to Point Registration ..................................................................................................46

10. Display ............................................................................................................................................ 47

10.1 Rendering .............................................................................................................................. 47

10.1.1 Elevation Rendering .................................................................................................. 47

10.1.2 Intensity Rendering ................................................................................................... 48

10.1.3 Texture Rendering ..................................................................................................... 48

10.1.4 X-Ray Rendering .........................................................................................................49

10.1.5 EDL Rendering ............................................................................................................49

10.1.6 HQS Rendering ...........................................................................................................50

10.2 Roaming ................................................................................................................................50

10.3 Profile view ........................................................................................................................... 51

10.4 Cutting Box ........................................................................................................................... 52

10.5 Pano view ..............................................................................................................................53

10.5.1 Panorama with Point Cloud Fusion ......................................................................... 54



4 / 86

11. Viewer .............................................................................................................................................55

11.1 Front View .............................................................................................................................56

11.2 Back View ..............................................................................................................................56

11.3 Left View ................................................................................................................................56

11.4 Right View ............................................................................................................................. 57

11.5 Top View ................................................................................................................................57

11.6 Bottom View ......................................................................................................................... 58

11.7 Projection Mode ................................................................................................................... 58

11.7.1 Orthographic Projection ........................................................................................... 58

11.7.2 Perspective Projection .............................................................................................. 58

11.8 View Operations ................................................................................................................... 58

11.8.1 Rotate ......................................................................................................................... 58

11.8.2 2D/3D View ................................................................................................................. 59

11.8.3 Bind/Unbind Point Cloud View Windows ................................................................ 59

11.9 Measurement ........................................................................................................................59

11.9.1 Point Picking .............................................................................................................. 59

11.9.2 Distance Measurement ............................................................................................. 60

11.9.3 Angle Measurement ...................................................................................................61

11.9.4 Area Measurement .....................................................................................................61

11.9.5 Spatial Measurement ................................................................................................ 62

12. Window ...........................................................................................................................................62

12.1 NewWindow .........................................................................................................................63

12.2 Duplicate Window ................................................................................................................63

12.3 Window Display State – Cascade ........................................................................................63

12.4 Tile .........................................................................................................................................64

12.5 Arrange ..................................................................................................................................64

12.6 Close Windows ..................................................................................................................... 64

13. Help .................................................................................................................................................64

13.1 Help Documentation ........................................................................................................... 65

13.2 Official Website .....................................................................................................................65

13.3 About .....................................................................................................................................65

13.4 Suggestions and Feedback ................................................................................................. 66

14. Project List ..................................................................................................................................... 66

14.1 Project ...................................................................................................................................66

14.2 Point Cloud Data .................................................................................................................. 68



5 / 86

14.3 Odometry Data .....................................................................................................................69

14.4 Vector Data ........................................................................................................................... 71

14.5 Control Point Data ............................................................................................................... 71

14.6 Add Data – Import Control Points .......................................................................................71

14.7 Add Data – Import Control Points .......................................................................................72

14.8 POS Data ............................................................................................................................... 74

14.9 Georeferencing Data ............................................................................................................75

15. Top-Right Settings ........................................................................................................................76

15.1 Profile Settings ..................................................................................................................... 77

15.2 View Settings ........................................................................................................................ 77

15.3 Canvas Settings ....................................................................................................................78

15.4 Point Size Settings & Uncolored Point Color Settings ...................................................... 79

15.5 Earthwork Volume Settings ................................................................................................ 80

15.6 License .................................................................................................................................. 81

16. Software Shortcuts ........................................................................................................................81

17. Point Cloud Viewing Window ....................................................................................................... 81

18. Raw Data Files ................................................................................................................................82

18.1 SLAM100 ................................................................................................................................82

18.2 SLAM2000 ..............................................................................................................................82

18.3 SLAM200/200E ......................................................................................................................83

18.4 SRTK100A ..............................................................................................................................84

18.5 S-PANO100 ............................................................................................................................84

18.6 Results Directory .................................................................................................................. 84



6 / 86

1. Software Overview

SLAM GO POST is a PC-side software designed to work with Feima handheld LiDAR

scanners, integrated within the professional version of UAV Manager. This software

supports processing data collected by the full series of Feima handheld LiDAR scanners.

It incorporates industry-grade high-precision mapping algorithms, capable of

producing high-accuracy, high-resolution colored point cloud results and panoramic

images.

The software also supports multiple point cloud rendering modes, including elevation,

intensity, texture, perspective, and EDL, and can automatically navigate along the

acquisition trajectory for immersive visualization. A variety of measurement functions

are provided, supporting point, line, surface, and other types of measurement outputs.

With its streamlined interface layout, guided project creation, and one-click processing

workflow, it allows users to quickly get up to speed.

2. System Requirements

Supports only 64-bit Windows 11, Windows 10, or Windows 7

3. Graphics Driver Compatibility

Colorization currently requires a CUDA driver version 12.x or above. Please update your

graphics card driver accordingly.

For NVIDIA GeForce GTX 1650 graphics cards, please upgrade the driver to at least

version 32.0.xxxx.
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4. Hardware Requirements

Item Minimum Recommended Description

CPU x86_64

architecture chip

Intel 13th Gen 8

-core

AMD, Intel, or domestic chips supporting

x86_64 are supported

GPU NVIDIA GeForce

2060 or above

NVIDIA

GeForce 4060

Only NVIDIA GPUs supported; CUDA driver

version≥ 12.1

RAM 16GB 64GB 32 GB or above recommended

5. Software Installation

SLAM GO POST is an auxiliary module that depends on the main UAV Manager software

and therefore requires UAV Manager to be installed first. You can obtain the software

installation package by visiting the following website.

FeimaUAVManager Download Link：

https://feimarobotics.net/service/softwares/

After the mainmodule is installed, open it via the desktop shortcut. Launch the SLAM

applicationmodule, click Download, and download the SLAM application suite.

https://feimarobotics.net/service/softwares/
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6. Software Interface

6.1 Menu Bar

Located at the top of the software interface, the menu bar contains all functions and

settings of SLAM GO POST Pro, divided into the following categories: File, Solve, Tools,

Display, View, Measurement, Window, Help.
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6.2 Common Toolbar

Located at the top of the interface, the common toolbar provides frequently used

functions. It mainly supports project-related operations, data processing, basic view

navigation, and some commonly used tools.

Except for the LOG viewing tool, all other functions in the common toolbar operate in

the same way as their counterparts in the menu bar. You can refer to the corresponding

sections under Menu Bar in this manual for details.

6.3 LOG

Used to view the latest log files of the active project. The log files are saved in the

project directory under the \log folder.

6.4 Quick Access Toolbar

The quick access toolbar is located on the left and right sides of the view window,

including tools for operations, view navigation, rendering, measurement, clipping

boxes, panoramic images, and point size settings. Components can be repositioned by

left-click dragging, and their visibility can be controlled via right-click.
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6.5 Project List Window

The Project List Window displays all currently opened projects and shows the data

directories contained within each project.

 Project names displayed in blue indicate the currently active project, on which

operations can be performed.

 Project names displayed in white indicate inactive projects, on which operations

cannot be performed.

Notice: The batch processing function is not subject to this restriction and can process

all currently opened projects.
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6.6 ViewWindow

The central area of the software interface is the View Window, which supports single

view, dual view, and multi-view display. It is primarily used for new view windows,

section views, panoramic views, and other types of view windows.

 The current view can be activated by left-clicking on it with themouse.

 Section views and panoramic view windows are used in conjunction with the

currently active view and can be launched via the Section and Panorama functions,

respectively.
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6.7 Processing Log & Progress Bar

The Processing Log is the project log output window, where task execution status and

success/failure notifications are displayed.

The Progress Bar, located at the bottom-left corner of the software, primarily shows

the current data processing progress. It displays the current progress name, overall

progress, and the specific value of overall progress.

7. File Menu

The File menu includes the following options:

 New Project

 Open Project

 Recent Opened Projects

 Save Project

 Save as Project

 Close All Projects

 Export datas

 Quit
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7.1 Create New Project

Create a new project for processing.

Function Description:

Data Import (*): Import the raw data directory to be processed. This is a required

parameter.

Project Name: Default is SlamProject. Can be modified as needed.

Create Time: The timestampwhen the project is created.

Device Type: Automatically recognized based on the device calibration file in the

imported raw data.

WorkMode (*): The mode used during data acquisition, such as handheld or backpack.

Coordinate System: This option appears only if GNSS data is present and valid in the

imported data. You can either use automatic coordinate system recognition or click the

gear icon on the right to manually select the coordinate system.

Project Path: Storage location of the new project. By default, it is created in the same

directory level as the raw data folder.
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7.2 Coordinate System Selection

Historical Coordinate Systems: Previously selected coordinate systems. You can click

the Apply button to apply a selected coordinate system, or delete/modify coordinate

systems from the list.

Custom Coordinate Systems: Create a custom coordinate system by clicking the New

button.

Create New Coordinate System: Specify the name of the new coordinate system,

select an existing ellipsoid or create a custom ellipsoid, choose a projection method,

and configure the corresponding projection parameters.
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7.3 Custom Ellipsoid

Enter the relevant ellipsoid parameters to create a custom ellipsoid.

7.4 Work Mode

User-Defined Mode & Eccentricity Settings
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Operation Mode – Pack100 + Pano100 Mode & Calibration File Download Settings

Enter the Pano100 device number and click Download to download the calibration file.

Notice: For more custom parameters, refer to：SLAM GO POST Pro Custom Solution Mode Data

Processing Workflow

7.5 Open Project

Open an Existing Project
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7.6 Recently Opened Projects

This section lists the projects most recently opened in the software. You can double-

click a project to open it directly, click the delete button in the top-right corner to

remove the selected project from the list, or click the Clear button to remove all project

records.
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7.7 Save Project

Saves all currently opened projects.

7.8 Save as Project

Saves the currently active project under a new name or location.
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7.9 Close All Projects

Closes all currently opened projects.

7.10 Export Data

Exports the data of the currently active project in .las format. The exported files are

saved to the selected export path.

7.11 Exit

Exits and closes the software.

8. Solve

The Solve menu includes the following functions: One-Click Processing, Batch

Processing, Point Cloud Mapping, Orientation, Point Cloud Optimization, Point Cloud

Denoising, Image Undistortion, Point Cloud Colorization, Panorama Generation,

Pedestrian Filtering, 3DGS Pre-training, 3DGS Training, and Cancel Processing.
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8.1 Onekey Solve

Performs one-click processing on the currently active project.

×
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Mapping Algorithm: Select from different mapping algorithms, categorized as

Algorithm A and Algorithm B.

Scene Selection: Choose between General Scene and Subway Scene. The default is

General Scene. Selecting Subway Scene switches to the subway-specific mapping

algorithm, improvingmapping performance and accuracy in subway environments.

Advanced Settings: Click the button for advanced mapping parameters to open the

Advanced Settings page. This page includes options for data acquisition stability,

specified processing time, and inner/outer bounding box filtering parameter.
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8.1.1 Panorama and Colorization – Image Source Settings

Image Source: Defines the source of stitched images for panorama generation and

point cloud colorization. Options include Built-in Camera and Panoramic Camera.

When Panoramic Camera is selected, the Panoramic Camera Parameters module is

activated:

Indoor/Outdoor: Select the type of acquisition scene according to the actual

environment. The default is Outdoor.

Mobile Time-Lapse Mode: If the panoramic camera acquires data in mobile time-lapse

mode, this optionmust be checked; otherwise, it should not be selected.

Panoramic Camera Data Path: Specify the folder path containing the panoramic

camera .insv files.

8.1.2 Point Cloud Colorization – Settings

Colorization Algorithm: Choose between Standard Colorization and High-Definition

Colorization.

Colorization Settings:

 Export Colorized Point

Cloud: Export the colorized

point cloud results in

standard .las format.
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 Output Non-Colorized Points: Option to include points that were not colorized in

the exported data.

 Output Upsampled Point Cloud: Export the colorized results as an upsampled

point cloud. The upsampled result is approximately 6–10 times larger than the original,

and processing time will increase accordingly.

8.2 Batch Processing

The batch processing function includes the following features:

Project List:

This displays other projects that have not yet been added to the processing list, as well

as newly created projects.

Integrated Create New Project: Click the New Project button at the bottom to create a

new project, equivalent to File→ New Project in themenu bar.

The left side of the project list shows all currently opened projects and newly created

projects. Click the button on the right of a project name to view its corresponding

information.Right-clicking a project in the list allows you to Edit Project, Save Project

As, Save Project, or Open Path.

Processing List:

Select projects from the left-side project list to add them to the right-side processing

list as needed. Even if there are already projects in the processing list, new projects can

still be added.

Use the four buttons below the processing list — Delete, Clear, Move Up, Move Down —

to adjust the selected projects in the list.

Click the gear icon next to a project name in the processing list to configure its

processing parameters. The parameter configuration page is the same as Solve → One-

Click Processing in themenu bar.
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Displays the project processing status, including Not Configured, Not Submitted,

Processing xx%, Completed, Queue Waiting, Processing Failed, etc.

Submit: Submits all unsubmitted projects.

Cancel: Cancels all processing tasks.

Closing the batch processing page does not affect ongoing batch processes. You can

reopen this page using the batch processing button to view the current batch status or

add new projects to the processing queue.
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8.3 Point Cloud Mapping

Performs point cloud mapping on the currently active project. The parameters are the

same as those in the One-Click Processingmapping settings.

 Mapping Algorithm: Select from different mapping algorithms, categorized as

Algorithm A and Algorithm B.

 Scene Selection: Choose between General Scene and Subway Scene. The default

is General Scene. Selecting Subway Scene switches to the subway-specific mapping

algorithm, improvingmapping performance and accuracy in subway environments.

 Advanced Settings: Click the button for advanced mapping parameters to open

the Advanced Settings page, which includes options for data acquisition stability,

specified processing time, and inner/outer bounding box filtering parameters.
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8.4 Orientation

Performs point cloud orientation on the selected point cloud. Two orientation modes

are available: Non-Rigid and Rigid.

Notice: Non-rigid orientation does not require selecting a point cloud and is processed

by default based on themapping results.

8.5 Point Cloud Optimization

Performs optimization on the selected point cloud. Two optimization modes are

available: Sparse Optimization and Dense Optimization.
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Dense Optimization: The optimized result retains at least 90% of the original data size.

Normal Optimization: The optimized result retains at least 30%-40% of the original

data size.

8.6 Denoise

Filters and removes isolated noise points in the point cloud file using statistical

algorithms.

Intensity denoising can effectively remove some glass noise, with options available for

indoor glass denoising and mixed indoor-outdoor modes.



28 / 86

8.7 Dedistortion

Performs dedistortion on image data based on factory calibration parameters to

ensure accurate panorama stitching and point cloud colorization.

Notice: For SLAM2000, SLAM200, and SLAM1000 devices, this function should be used

after the point cloud colorization step.

8.8 Point Cloud Coloring

Performs texture on the selected point cloud. Parameters are the same as those in the

One-Click Processing colorization settings.

Image Source: Defines the source of stitched images for panorama generation and

point cloud colorization. Options include Built-in Camera and Panoramic Camera.

When Panoramic Camera is selected, the Panoramic Camera Data module is activated:

Mobile Time-Lapse Mode: If the panoramic camera acquires data in mobile time-lapse

mode, this optionmust be checked; otherwise, it should not be selected.

Panoramic Camera Data Path: Specify the folder path containing the panoramic

camera .insv file.

Colorization Algorithm ： Three colorization algorithms are available: Standard

Colorization, High-Definition Colorization, and Enhanced High-Definition Colorization.

Standard Colorization: Suitable for most scene types.

High-Definition Colorization: Provides noticeably higher clarity compared to

standard colorization and is suitable for most scenes.
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Enhanced HD High-Definition Colorization: Includes an additional position (POS)

optimization step, offering significantly higher clarity than High-Definition Colorization.

Suitable for scenarios requiring the highest clarity, with an increase in processing time.

Colorization Output Settings：

Export Uncolored Points:Option to export point cloud data that remains uncolored.

Export Upsampled Point Cloud: Outputs an upsampled version of the colorized point

cloud. The upsampled result is approximately 6 – 10 times larger than the non-

upsampled result, and the corresponding processing time will also increase.
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8.9 Panorama Generation

Generates stitched panoramic images, with options for Built-in Camera or Panoramic

Camera.

Image Source: The image source for panorama stitching and colorization. Options

include the built-in camera and an external panoramic camera.

When selecting the Panoramic Camera, the Panoramic Camera Data module will be

activated:

 Indoor/Outdoor: Classify the acquisition scenario according to actual conditions.

The default option is Outdoor.

 Motion Delay Mode: If the panoramic camera collects data in motion delay mode,

this optionmust be checked; otherwise, it cannot be selected.

 Panoramic Camera Data Path: Specify the folder path where the panoramic

camera insv files are stored.
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8.10 Move Object Filter

Removes dynamic objects from the selected dataset through filtering.

8.11 3DGS Pre-Training

After selecting the folder path where the panoramic camera INSV files are located, click

Confirm to start the 3DGS pre-training. Scence type Selection option according to the

specific environment; no need changes are needed for View Setting.
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8.12 3DGS Training

Performs further training based on the pre-training results of the active project. Two

training modes are available: Local Training and Cloud Training. For detailed

instructions, refer to the documentation: /zh/slam/3dgs/training.

https://wiki.feima.cool/en/slam/3dgs/training

https://wiki.feima.cool/en/slam/3dgs/training
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8.13 Cancel Processing

Stops the currently running processing task.

9. Tools

The Tools menu includes the following functions:

 Coordinate conversion setting

 Export XML

 Format convert

 PPK solve

 Accuracy report

 Cybergeo export

 Data frame

 Data registration

 Data cut

 Point to point registration

 Create DOM

 Data stitching

 Volume calculations

 Change analysis
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9.1. Format Convert

Convert the raw observation files into the standard RINEX format required for post-

differential processing.

Import requires selecting the corresponding O file as well as ephemeris files such as P

files located in the same directory.
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9.2 PPK Solve

Perform post-processed kinematic (PPK) calculations on the epoch data within a given

period to improve the fixed rate and achieve higher positioning accuracy. This method

is used when scanning areas without network coverage, where RTK connection is

unavailable.

Parameters：

 Rover Data: Path to the rover observation data.

 Base Station Data: Path to the base station observation data.

 Base Station Parameters:

 RINEX Header Information: Read base station coordinates from the RINEX header

file.

 Automatic: Automatically calculate the base station coordinates.

 User Defined: Manually input the base station coordinates.
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 Longitude: Longitude of the base station.

 Latitude: Latitude of the base station.

 Height: Height of the base station.

 Navigation Data Selection:

 Rover: Use navigation file information recorded in the rover data.

 Base Station: Use navigation file information recorded in the base station data.

 Output Path: Path to save the calculated results.

9.3 Accuracy Report

Open the orientation accuracy report of the currently active project. The report is

located in the project path under the \gcp folder.
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9.4 Data Frame

Perform framing and cropping on the selected point cloud file based on either a

standardmap scale or a fixed size.

 Frame by Scale: Divide the point cloud according to a standard map scale.

 Prefix: Text prefix added to the framed output files.

 Scale: Select themap scale for framing.

 Frame Size: Select the size of each frame.

 Extension: Distance to extend beyond the frame boundary.

 Starting Point X/Y Coordinates: X and Y coordinates of the starting point for

framing.

 Fixed Size: Perform framing based on a fixed frame size.

 Prefix: Text prefix added to the framed output files.

 Frame Length: Fixed length of each frame.

 FrameWidth: Fixed width of each frame.

 Frame Size: Selection of frame size.

 Extension: Distance to extend beyond the frame boundary.

 Starting Point X/Y Coordinates: X and Y coordinates of the starting point for

framing.
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9.5 Data registration

Merge two sets of point cloud data with overlapping areas by selecting matching points

in the overlap region. This process transforms the coordinates of the registered point

cloud to align with the reference point cloud.
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Parameters:

Select Points: After clicking this button, hold the Ctrl key and directly select

corresponding points on the point cloud for reference and registered datasets.

Reference Data / Registered Data Settings (example shown for Reference Data):

Data Selection Box: Choose between the reference data or the registered data.

The matched points settings button allows manual point coordinate input, opening a

file to import points, clearing all points, and adjusting the point cloud display color.

Delete: Deletes the selected point in the row.

ICP Parameter Settings:

 Grid Size: Sampling interval.

 Distance Threshold: Maximum distance between corresponding points; matching

points exceeding this threshold are excluded from the calculation.

 Number of Iterations: Number of iterations for the ICP algorithm.

 Iteration Distance: Difference between consecutive iteration calculations; if less

than this value, the iteration terminates.
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9.6 Data cut

Crop and export the selected point cloud using the imported vector file as the

boundary.

9.7 Data Cut Output Mode

 File First: Intersect the selected point cloud files with the vector shapes, producing

multiple cropped files for each point cloud.

 Range First: Crop all point cloud data according to the number of vector shapes.

 Cropping Range: Import the vector file defining the cropping boundary.

 Cropping Extension: Distance to extend beyond the cropping boundary.
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9.8 Create DOM

Generate a DOM from the selected point cloud at the chosen resolution. The results are

saved to the selected output path, with the default DOM format being TIFF.

9.9 Multiple fights of stitching

Perform stitching on opened projects and manually added projects. For detailed

operation instructions, please refer to the document:

/zh/slam/slamgopost/stitching_guide.

If all projects to be processed already have oriented results, the connection diagram

and connection information can be skipped. If any projects have unoriented results,

the actual connection information for each project must be provided.
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9.10 Volume Calculations

The volume calculation function supports computing the earthwork volume within the

drawn area and exporting multiple calculation reports.

Volume calculation includes parameter settings, result display, thumbnail display of

the calculation area, progress bar, roof removal, and report export functionality.
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体积计算

Parameter:

 【Base Surface Type】

The base surface type can be Plane, Fitted Plane, or Complex Surface. When Plane is

selected, the Base Surface Height must be entered; the software will use this height as

the reference for calculating cut and fill volumes.

When Fitted Plane is selected, the interface will display fitted coordinate data and

operation buttons. Add the coordinates of the fitted plane by clicking the Add Point

button, holding the Ctrl key, and clicking on the original point cloud. The coordinates

will appear in the dialog box. In the cascade interface, added fitted coordinates can be

deleted or cleared, and coordinates can also be added manually.

When Complex Surface is selected, a DEM file must be provided; DEM data supports *.tif

and *.tiff formats.

 【 Sampling Size 】 Sets the sampling interval for volume calculation. Smaller

intervals increase calculation accuracy but may reduce computational efficiency.

×
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 【Method】The calculation method can be Triangulated Network or Grid Network.

Selecting Triangulated Network starts the calculation directly. Selecting Grid Network

requires setting the Grid Size according to the precision of the original data and

calculation requirements.

 【Grid Size 】 When using the Grid Network method, set the grid size. The grid size

should be determined based on the precision of the original data and the calculation

requirements.

 【Category】The category setting allows calculation based on the classification of

point cloud data. If the point cloud is not classified, the default 0 – Default is used. If

classification exists, select the required category for volume calculation.

 【Maximum Edge Length】When the drawn boundary or point cloud boundary

forms a concave polygon, volume calculation may become inaccurate. The Maximum

Edge Length is used for concave polygon calculations to obtain accurate volumes. The

maximum edge length should be greater than twice the sampling size.

 【Step Range】For stepped volume calculations, set the Step Range and Step

Interval. The software will calculate the fill and cut volumes within each stepped

reference surface.

 【Output Weight】Enter the weight of the material; the software will calculate the

corresponding earthwork weight.

 【Results】The dialog displays calculation results, including the area, fill volume,

and cut volume of the drawn boundary. If the Step Range option is enabled, results for

each step, including its range and fill/cut volumes, will be shown.
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 【Result Preview】Hover the mouse over the display dialog on the right to interact

with the calculation area. Use the mouse wheel to zoom in or out, hold the left mouse

button to rotate the view, and hold themiddle mouse button to pan the display.

 【Report Export】Click the Report button to export a volume calculation report in

*.pdf format. The report includes blocks, ranges, surface areas, projected areas, fill

volumes, cut volumes, total volume, total weight, and a thumbnail of the calculation

area.

9.11 Change Analysis

The Change Analysis function can calculate and analyze the volume changes between

two periods.

The volume change analysis interface includes data selection, settings, results display,

calculation area thumbnail display, and report export functions.

During volume change analysis, a progress bar is provided to display the ongoing

calculation status.
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Specific Parameters

Data: Includes Base Data and Post-Change Data. Point cloud data can be directly

selected from existing projects.

Settings: Calculation settings require specifying point cloud category, grid size,

sampling size, and maximum edge length. These four parameters correspond to those

used in Volume Calculation.

Results Display, Result Preview, and Report Export: These three operations are

consistent with the corresponding operations in Volume Calculation.

9.12 Point to Point Registration

When no control points were collected during data acquisition, and the positions of

some points were obtained later via RTK stakeout, Point to Point registration can be

used to import the control point file and perform orientation by selecting the

corresponding control point positions on the point cloud.

Notice: Before selection, import the control point file (Northeast Elevation) first, then

click the points you want to select, hold down Ctrl to make selections after clicking Pick.
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10. Display

The Display menu includes various point cloud rendering modes; point cloud roaming

modes: free roaming and video roaming; and display options for cross-section, clipping

box, and panorama.

10.1 Rendering

Displays the point cloud in the view using the selected renderingmethod.

10.1.1 Elevation Rendering

Renders the point cloud in the view based on elevation values.
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10.1.2 Intensity Rendering

Renders the point cloud in the view based on variations in intensity attributes.

10.1.3 Texture Rendering

Renders the point cloud in the view using RGB color attributes. This option is only

effective for colorized point clouds.
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10.1.4 X-Ray Rendering

Renders the point cloud in the view based on the current rendering mode

(Elevation/Intensity/Texture) with an additional perspective effect applied.

10.1.5 EDL Rendering

Renders the point cloud in the view based on the current rendering mode

(Elevation/Intensity/Texture) with the Eye-Dome Lighting (EDL) effect applied.
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10.1.6 HQS Rendering

Renders the point cloud in the view based on the current rendering mode

(Elevation/Intensity/Texture) with the High-Quality Shading (HQS) effect applied. In the

figure below, View 1 shows Texture Rendering + HQS effect (right), while View 2 shows

Texture Rendering (left).

10.2 Roaming

Automatic Roaming
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Performs a dynamic roaming display of the point cloud data loaded in the main view,

based on the acquisition route (odometry file).

Video Roaming

Opens the onboard video recorded by SLAM2000, SLAM1000, or SLAM200 projects and

displays the point cloud in synchronization with the video.

10.3 Profile view

Draws and displays cross-sections of the point cloud loaded in themain view. Section

parameters can be configured via Settings > Section Settings in the upper right corner.

The section is defined by selecting two points with themouse to set the direction, and

a third point to define the width. The section view will then be automatically displayed

in the Section Window.
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10.4 Cutting Box

Clips and displays the point cloud in the main view along the X, Y, and Z directions,

making it convenient to examine internal structures or specific regions of interest

within the point cloud.
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Clipping Box Operations：

 Clipping: Left-click the arrow and drag forward or backward with the mouse to

perform clipping.

 Rotation: Left-click the rotation ring on any face of the clipping box and drag the

mouse to rotate the clipping box.

 Translation: Left-click the yellow move button beside the clipping box and drag

themouse tomove it.

 Adjustments via Clipping Box Parameters：

 Reference Point: The calculation base point when adjusting the length, width, or

height values.

 Length / Width / Height: The overall dimensions of the clipping box.

 Fine Adjustment: Fine-tune the dimensions and rotation angles of the clipping

box.

 Show / Hide: Display or hide the clipping box.

 Reset: Reset all parameters of the clipping box.

 Export: Export the data within the clipping box in LAS format.

10.5 Pano view

Displays the panoramic results generated in the current project.

When the point cloud has been processed and the panorama has been generated, add

the panorama POS into the view to launch the Panorama Viewer. POS points are

displayed in blue by default, captured POS points are shown with a yellow rectangle,

double-clicking a POS point opens the corresponding panorama, and the POS point of

the opened panorama will be displayed in red. By selecting and double-clicking a POS

point, the panorama corresponding to that position will be displayed.
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10.5.1 Panoramawith Point Cloud Fusion

This function is currently supported only when using the 360 ° × 360 ° panorama

module. When the point cloud has been processed and the panorama has been

generated, add both the point cloud file and POS file into the view and start the

panorama function. At this point, once the panorama is opened, the software will

automatically enable this feature and display the corresponding point cloud data in the

panorama view. Measurements on the panorama with point cloud overlay can be

performed using the Distance Measurement tool button.
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11. Viewer

The Viewmenu includes six directional views, orthographic/perspective projection

switching, and basic view operations.

11.1 Front View

Switch themain view perspective to the Front View.

Front View



56 / 86

11.2 Back View

Switch themain view perspective to the Back View.

Back View

11.3 Left View

Switch themain view perspective to the Left View.

Left View



57 / 86

11.4 Right View

Switch themain view perspective to the Right View.

Right View

11.5 Top View

Switch themain view perspective to the Top View.

Top View
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11.6 Bottom View

Switch themain view perspective to the Bottom View.

Bottom View

11.7 Projection Mode

11.7.1 Orthographic Projection

Displays the point cloud in themain view in orthographic projectionmode.

11.7.2 Perspective Projection

Switches the point cloud in the main view to perspective projectionmode.

11.8 View Operations

Centers all data within the view.

11.8.1 Rotate

Activate the Rotate function. At this time, the left mouse button is used for rotation.

Hold the left mouse button and drag to rotate, allowing you to browse the data within

the view.。
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11.8.2 2D/3D View

Switch the view between two-dimensional and three-dimensional display.

11.8.3 Bind/Unbind Point Cloud ViewWindows

Create multiple windows and add the same point cloud data to each window. Click this

button to bind or unbind the point cloud view windows.

11.9 Measurement

The Measurement menu includes Point

Picking, Distance Measurement, Angle

Measurement, Area Measurement, and Spatial

Measurement.

11.9.1 Point Picking

Activates the point picking function. Selecting a point in the view displays its attribute

information.
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11.9.2 Distance Measurement

Measures the spatial distance between two selected points.

This function can also measure distances for point clouds in the panorama view. When

the panorama is overlaid with point cloud data, measurements and analysis can be

performed. Other measurement functions are temporarily unavailable in the panorama

view.
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11.9.3 Angle Measurement

Measures the angle between the line formed by two selected points and the horizontal

direction, with the line’s endpoint serving as the vertex of themeasured angle.

11.9.4 Area Measurement

Measures the area of a drawn closed region. Left-click to draw and double-click to

finish drawing.
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11.9.5 Spatial Measurement

Measures the difference in three-dimensional coordinates between two points.

12. Window

The Window menu includes options to create a new window, duplicate a window;

window state settings: Cascade, Tile, Arrange; and Close Window.
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12.1 NewWindow

Creates a new view window.

12.2 Duplicate Window

Duplicates the currently active window. Temporarily unavailable.

12.3 Window Display State – Cascade

All view windows are displayed in a cascading layout.
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12.4 Tile

All view windows are displayed in a tiled layout.

12.5 Arrange

All view windows are arranged and displayed according to their window numbers.

12.6 Close Windows

Closes all currently open view windows.

13. Help

The Help menu includes Help Documentation, Official Website, About, and Feedback.
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13.1 Help Documentation

Click to open the official help documentation website, where you can viewmanuals

and other materials related to software features.

13.2 Official Website

Click to open the Feima Robotics official website and learn more about the company.

13.3 About

Click to view software version number, introduction, copyright information, and other

details.

关于SLAM GO POST Pro ×

SLAMGO POST Pro

V3.0.0.28.AlphaAM GO POST Pro具备点云建图、去噪、薄化、定向、赋色、拼接、裁切分剔

3.0.0.28.Alpha
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13.4 Suggestions and Feedback

Click to provide feedback on the software, including suggestions, comments, or bug

reports.

意见反馈

请在下方提交您的问题和建议。

选择

问题

输入您的邮箱地址，方便我们答复您的反馈。

邮箱地址

请输入邮

14. Project List

All functions in the Project List window are displayed and accessed by right-clicking the

selected row.

14.1 Project

Activate, edit, export, open the path, and perform other operations on the selected

project. In the Project List window, right-click the row of the selected project name to

access the related functions.
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 Activate Project: Activates the currently selected project.

 Edit Project: Edits the currently selected project.

 Close Project: Closes the currently selected project.

 Save Project: Saves the currently selected project.

 Save Project As: Saves the currently selected project under a new name.

 Open Path:Opens the directory where the project is located.

 Batch Export: Exports the data in the currently selected project to LAS format in

batch.
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14.2 Point Cloud Data

In the Project List window, right-click a selected point cloud file to access related

functions.

Perform operations on the selected point cloud data such as adding/removing from the

view, zoom to view, show/hide, export, open path, and view properties.

Add to View: Adds the currently selected point cloud to the active view for display.

Remove from View: Removes the currently selected point cloud from the active view.

Zoom to View: Centers the currently selected point cloud in the active view.

Show/Hide: Shows or hides the currently selected point cloud (effective after the point

cloud has been added to the view).

Export Data: Exports the currently selected point cloud.

Open Path: Opens the save directory of the currently selected point cloud file.

Properties: View the attribute information of the point cloud.
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14.3 Odometry Data

Perform operations such as adding, removing, showing/hiding, and exporting views for

the selected odometry data.

In the project list window, right-click the odometry file to access the related functions.
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 Add to View: Adds the currently selected odometry data to the active view for

display.

 Remove from View: Removes the currently selected odometry data from the active

view.

 Zoom to View: Centers the currently selected odometry data in the active view.

 Show/Hide: Shows or hides the currently selected odometry data (effective after

the data has been added to the view).

 Export Data: Exports the currently selected odometry data.

 Open Path:Opens the save directory of the currently selected odometry data file.

 Properties: View the attribute information of the odometry data.
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14.4 Vector Data

This function is currently unavailable.

14.5 Control Point Data

Perform operations on the selected control point data such as import, edit, and display.

In the Project List window, right-click the row of the selected control point data or

control point file to access related functions.

14.6 Add Data – Import Control Points
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14.7 Add Data – Import Control Points

 Coordinate Type: Select the coordinate system type for the control points.

 Projected Coordinates: Set the imported control points to the projected

coordinate system.

 Datum Type: Select the ellipsoid datum of the control point file.

 Projection Type: Select the projected coordinate system of the control point file.

 OK: Add the control point file.

 Cancel: Cancel the import of the control point file.

 Add to View: Adds the currently selected control points to the active view for

display.

 Remove from View: Removes the currently selected control points from the active

view.

 Edit Control Points: Modify the coordinate system, corresponding relationships,

and other settings of the imported control point file.
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Coordinate System: Modify the coordinate system of the control points.

 Projected Coordinate System: Change the imported control points to a projected

coordinate system.

 Local Coordinate System: Change the imported control points to a local

coordinate system.

Datum and Projection

 Datum:Modify the ellipsoid datum of the control point file.

 Projection Type:Modify the projected coordinate system of the control point file.

Reference Points and Matching Points Table

 Reference Point: The name of the currently selected control point.
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 Matching Point Index: The index of the matching point corresponding to the

currently selected control point; editable when the default order does not match.

 Check Point: Set the selected control point as a check point, which does not

participate in control but is used for accuracy verification; the point must have a

correspondingmatching point.

 Reference Point X\Y\Z: Coordinates of the control point.

 Matching Point X\Y\Z

 Match: Automatically adjust the corresponding matching point based on the

relative position of the control points.

 Undo: Revert the last operation.

 Reset: Return to the initial state when entering the control point editing interface.

 OK: Save the current modifications and exit the control point editing interface.

 Cancel: Discard changes made in the control point editing interface and exit.

 Zoom to View: Center the currently selected control points in the active view.

 Show/Hide: Show or hide the currently selected control points (effective after the

control points have been added to the view).

 Export Data: Export the currently selected control points as a text file (*.txt).

 Open Path: Open the save directory of the currently selected control point file.

14.8 POS Data

Perform operations on the selected POS data such as adding/removing from the view,

show/hide, and export. In the Project List window, right-click the POS file to access

related functions.

/隐
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 Add to View: Adds the currently selected POS data to the active view for display.

 Remove from View: Removes the currently selected POS data from the active

view.

 Zoom to View: Centers the currently selected POS data in the active view.

 Show/Hide: Shows or hides the currently selected POS data (effective after the

POS has been added to the view).

 Export Data: Exports the currently selected POS data.

 Properties: View the attribute information of the POS data.

14.9 Georeferencing Data

Perform operations on the selected georeferencing data such as adding/removing from

the view.

In the Project List window, right-click the selected georeferencing data to access

related functions.



76 / 86

By using Measurement → Point Picking to click on a georeferencing data point, you can

view the corresponding image and name of that point; double-clicking the image

opens a detailed view page where you can see image details and modify the point

name.

15. Top-Right Settings

The Settings menu in the top-right corner includes Profile Settings, View Settings,

Canvas Settings, Point Size Settings, Earthwork Volume Settings, and License.
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15.1 Profile Settings

Set the profile width, including fixed width and drawn width modes, and configure the

radius value for fixed width.

15.2 View Settings

Configure the display of the coordinate axes and legend for the current view window.

These settings are independent for each view.

T 剖面设置

旧 视图设置

口 画布设置

◎点

坐标轴

图例
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15.3 Canvas Settings

Customize the background color of the view window. These settings are independent

for each view.
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15.4 Point Size Settings & Uncolored Point Color Settings

Modify the point size of point cloud data in the current view.

Uncolored Point Color Settings: When coloring the point cloud, if the option to output

uncolored points is selected, this parameter allows setting the display color and

transparency of uncolored points in the coloring results. The set RGB color also applies

to the exported point cloud results.
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15.5 Earthwork Volume Settings

Mainly used for the Earthwork Volume module – set the surface colors before and after

changes for change analysis, calculation units for volume computation and change

analysis, and parameters related to output reports. This includes point cloud color

settings, area/volume/weight unit settings, and company name and logo settings for

the output report.
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15.6 License

Import the license file to enable software processing through a software-based license.

16. Software Shortcuts

17. Point Cloud Viewing Window

The shortcut keys for the point cloud viewing window are as follows:

↑↓←→ : Pan

Q, E : Rotate the point cloud counterclockwise/clockwise relative to the view

W, S : Rotate the point cloud up/down relative to the view

A, D : Rotate the point cloud left/right relative to the view :

, - : Zoom in/out

Spacebar : Fit all
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18. Raw Data Files

The following explains the raw file formats for the SLAM product series. The necessity

indicated is only evaluated in terms of data processing.

18.1 SLAM100

SLAM100 Raw Data Directory Structure:

 camera00 – Storage directory for images from camera 00 (required data)

 camera11 – Storage directory for images from camera 11 (required data)

 camera22 – Storage directory for images from camera 22 (required data)

 240301-024859_00266IMU_DATA_0001.txt – Raw IMU recording file (required data

 240301-024859_00266_RASTER_DATA_0001.txt – Raw raster recording file

(required data)

 240301-024859_00266_SLAM_Pandar_0001_0.pcap – Raw LiDAR recording file

(required data)

 Required Data feima_slam100_calib.yaml – Device calibration file (required data)

18.2 SLAM2000

SLAM2000 Raw Data Directory Structure:

 20240718-130226_Ec_Data.fmraster – Raw raster recording file (required data)

 20240718-130226_Hp_Imu.fmimr – High-precision IMU raw recording file (required

data)

 20240718-130226_Lidar_Data.fmlidar – Raw LiDAR recording file (required data)

 20240718-130226_Lidar_Imu.imu – LiDAR onboard IMU recording file (required

data)

 20240718-130226_LpImu.fmimr – Low-precision IMU recording file (required data)

 COLOR_CAM – Fisheye camera data folder (required data)
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 Description_File.txt – Description file (required data)

 slam_calib.yaml – Device calibration file (required data)

 REAL_SLAM – Real-time point cloud result folder (optional; large size, can be

skipped for post-processing only)

 OPTICAL_CAM – Visual camera data folder (optional; large size, can be skipped for

post-processing only)

18.3 SLAM200/200E

SLAM200 Raw Data Directory Structure:

 20250528-132239_Ec_Data.fmraster – Raw raster recording file (required data)

 20250528-132239_Hp_Imu.fmimr – High-precision IMU raw recording file (required

data)

 20250528-132239_00025_SLAM_Pandar_0001_0.fmlidar – Raw LiDAR recording file

(required data)

 20250528-132239_Rtk.dfnav – Device GNSS data recording file; required for

airbornemode (required data)

 20250528-132239_Rtk.fmcompb – Device onboard flow station data recording file

(required data)

 20250528-132239_Rtk.fmnav – Device GNSS data recording file; not used for

airbornemode (required data)

 20250528-132744_Mark_Point.fmmark – File recording control points, static points,

and points of interest during device acquisition (required data)

 COLOR_CAM – Fisheye camera data folder (required data)

 Description_File.txt – Description file (required data)

 pano_calib.yaml – Panoramic camera calibration file (required data)

 slam_calib.yaml – Device calibration file (required data)

 REAL_SLAM – Real-time point cloud result folder (optional; large size, can be

skipped for post-processing only)
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18.4 SRTK100A

SRTK100A Raw Data Directory Structure:

 Firmware – Firmware (optional)

 Log – Device logs (optional)

 Nav – Real-time differential trajectory file, i.e., RTK trajectory file (required data)

 PpK – Post-processed differential (optional)

 Raw – Raw data (optional)

 Rtcm – RTCM protocol files (optional)

 L-System – System files (optional)

18.5 S-PANO100

S-PAN0100 Panoramic Camera Raw Data Directory Structure:

 config – Raw data package (optional)

 Log – Camera debug logs (optional)

 pano – In-camera stitched photos and video data (optional)

 src – External stitched photo data (required data)

 updata – Update package (optional)

18.6 Results Directory

Results Folder. Explanation of the results directory folder structure:

 clip – Point cloud clipping output directory

 denoise – Point cloud denoising output directory

 dimages – Distortion correction output directory

 filter – Pedestrian filtering output directory
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 frames – Output directory for photos extracted from fisheye camera videos of

SLAM2000/SLAM200/SLAM1000

 gcp – Oriented point cloud output directory

 log – Processing log output directory

 odometer – Odometer output directory

 optimizer – Optimized point cloud output directory

 pano – Panoramic image output directory (SLAM100 in-camera stitching results)

 pos – POS output directory for images (within the dimages folder)

 register – Stitching and transformation output directory

 subdiv – Point cloud subdivision output directory

 temp – Temporary data output directory, including original mapped point cloud

 texture – Point cloud coloring output directory

 *.sprj – Project files

 Text File Format Explanation

 The following explains the text file formats generated during the SLAM data

processing.

 Image POS Files

Text file formats within the POS folder under the project directory are as follows:

 camera_pos.txt

 camera_pos_opk.txt

 Panoramic POS Files

Text file formats within the pano folder under the project directory are as follows:

 pano_pos.txt – Panoramic image POS

 pano_pos_opk.txt – Panoramic image POS after orientation

 Odometer Files
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Text file formats within the odometer folder under the project directory are as follows:

 HF_odometry.txt
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